FROM MERCATOR TO GOOGLE STREET VIEW

PART 1
Cartography

Topic

The concept of Europe

Subjects
History, Geography, Science, Geodesy

Level

Students learn the basics of making maps.

Aims

What are geographic maps for? What do
geographic maps represent? How to draw a map?

Improve the ability to reflect on changes in the
concept of Europe, and from that draw conclusions.
projecting the Earth's surface onto plans and maps,
using Mercator projection,

Skills

reflections, conclusions

Duration

50 minutes

Resources

maps of Europe from different time periods
modern Atlas
computer – internet - library
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INTRODUCTION
Who was Mercator?
Mercator was born in Flemish territory in 1512 and
studied Geography, Geometry and Astronomy. According
to the historians he was an excellent cartographer, having
developed important studies that led him to the
elaboration of maps of inestimable value and practical
use.
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PROJECTION OF THE EARTH’S SURFACE ONTO A PLANE
The Earth as a celestial and geometrical body
The physical surface of the Earth as a celestial body is mostly covered with land - which rises to
a variety of altitudes - and seas. As a geometrical body it is of irregular shape and has no
mathematical basis. Therefore, in the context of geodesy, navigation and mapping we take it as
a rotary ellipsoid or even a sphere (Figure 1). These are geometrical bodies for which
mathematical laws and relations apply which allow solving all the survey, mapping and
navigation problems.

Earths surface

Ellipsoid
Sphere
Figure 1: The Earth as a geoid, rotational ellipsoid and sphere
A rotational ellipsoid, which imitates the shape of the Earth, is generated by an ellipse rotated
around its short axis, which is assumed to coincide with the actual axis of the Earth (Figure 2).
Dimensions of the ellipsoid, which would be closer to the form of the Earth, were being
calculated by many experts as early as the 19th century. The calculations differ notably in the
kurtosis of the ellipsoid (length of the vertical axis).
a - semi-major axis,
b - semi-minor axis (Figure 2)

Figure 2: Ellipsoid with the axes
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In the countries of Central Europe the Bessel ellipsoid proved to be the most useful (the best
approximation of Earth). It was used in that area from the mid-19th century to the beginning of
the 21st century.
In the countries outside this region the ellipsoids were used that were best suited to their areas
of Earth's surface. Therefore it was impossible to connect geodetic networks and maps of
different countries.
Only the modern satellite geodetic measurements enable calculating and determining the socalled global rotational ellipsoid. This allows the best display of the actual area. The rotational
ellipsoid used is denoted WGS84 (World Geodetic System 1984).

Historical development of the projection of the Earth on a map
The oldest map we know is of Babylonian origin. It is a tablet of clay and containing the
representation of two mountain ranges and, in the centre of them, a river, probably the
Euphrates. Its age is not known for sure. Experts estimate between 2400 and 2200 years
before the Christian era.

In ancient Greece - during the sixth century BC - with the contribution of sciences, philosophy,
mathematics and arts, methods were developed which were capable of representing the
terrestrial surface.
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Till the 6th century, before the beginning of our era, it was believed that the Earth had the form
of a disc, which was surrounded by oceans. In the 5th to 4th century BC, it was mostly accepted
that the Earth was round, which was confirmed by observations of outgoing ships on the horizon
and the Earth's shadow on the moon during its eclipse. The radius of the globe was calculated.
The Greeks conceived the notion of the sphericity of the Earth, of Poles, Equator and Tropics;
the idealization of the first systems of projections and the conception of longitude and latitude.
The great name of antiquity was Ptolemeus. He lived in the second century of our era, was an
astronomer, geographer and cartographer, laid the foundations of geography, mathematics and
cartography in the book entitled “Guide to Geography” (Geographiké hyphegesis). This work
only came to the knowledge of European scholars with the translation into Latin in 1405.
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In the Middle Ages, in addition to the location, the maps were understood as forms of cultural
expression.
Despite numerous astronomical and geodetic observations and measurements in the Middle
Ages, it was not until the 17th century that the physicists Newton and Huygens proved that the
Earth has the shape of an ellipsoid. In the 19th century, Gauss redefined the shape of the Earth,
and he clearly distinguished between the natural surface of the planet, the geoid as a physically
defined shape under the sea level, and an ellipsoid as a reference (approximate) model of the
Earth's surface.
Today, Cartography has an immense technological set that allows the availability and easy
access to a series of contents represented by the maps.



Digital Cartography, Geoprocessing, Remote Sensing, etc.
Software and pages like: Google Earth, Google Maps, Wikimapia, ArcGIS Online, among
others.

5

Activity 1
What should we consider when drawing a geographic map?

Mapping Projection (Mercator - Gauß-Krüger – UTM projection)
The exact determination of the position, shape and dimensions of an object on the Earth's
surface is possible on the basis of applied mapping projections (method of transformation of the
Earth´s surface onto the plane).
The fact is that when transforming the Earth's surface onto the plane (irrespective of whether it
is a transformation from a rotation ellipsoid or a sphere) this is not possible without deformation.
The plan or map will always be a minimized view of a part of the Earth's surface and will be
deformed. Obviously we use projections in which these deformations are so small that they can
be neglected (Figure 3).

Figure 3: Contact projections (projection plane tangent to the Earth's surface)
The Mercator projection was thought of and first used in 1569 by a Belgian astronomer,
surveyor and cartographer Gerardus Mercator (Gerard de Cremer). This is a cylindrical
projection in which the transformation of the meridians and parallels become straight lines which
intersect at right angles. Mercator’s cartographic projection is conformal (maintains the right
value of angles on the rotational ellipsoid even when they are transformed into the plane)
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The left hand image underneath represents the common cylindrical projection, which obviously
isn’t conformal. The right hand image shows the Mercator projection, which clearly is conformal.
This allows the navigators to represent the vessel’s course as a straight line.
On both images you can notice that the distance between two consecutive circles of latitude
increases when getting closer to the poles.
This projection is not accurate in distances.

Also the Mercator projection exaggerates the land masses located far from the equator in their
size. That’s what you see underneath.
The blue area represents Greenland, the red one is Africa.
On the Mercator maps they have more or less the same size while in reality Greenland is much
smaller.

Many countries chose the Mercator projection for their state surveys.
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The Gauss-Krüger projection is the Mercator’s transverse projection on the Bessel ellipsoid. In this
projection, the cylinder is not tangent to the equator, but to a set of meridians, like the Greenwich
meridian and 180° meridian.
The Gauss-Krüger projection divides the surface of the ellipsoid into the so-called meridian zones
which are 3º wide (Figure 5). Meridian zones extend from the southern to the northern pole of the
Earth and we begin their counting at the Greenwich meridian. This projection preserves the
angles, but not the distances so that the areas at 0° N and 90° W and 90° E are “enlarged”.
Around the contact meridian the Gauss-Krüger zones are mapped in their correct size.
The deformations in length that this projection causes increase with the distance to the central
meridian (x-axis). This projection is very suitable for countries that are vast from North to South,
but very narrow in width (East to West), like for example Chile.

The UTM projection (Universal Transversal Mercator projection) is very similar to the GaussKrüger projection. The primary difference is that its reference rotational ellipsoid is Hayford (its
code is WGS84 – not Bessel as at the Gauss-Krüger projection). Its meridian zone is 6 ° wide.
The UTM projection does not apply to the poles of the Earth's ellipsoid because there the
meridian zones are too narrow.
The importance of the UTM projection is in its universal application throughout the globe.
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Activity 2
Use three historic maps from different time periods.
-How is your own country represented? Is it accurate?

-Why does it look like that?

- How is Europe represented? What is different compared to a map of today?
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Part 2
Just like with Mercator’s maps we want to be able to determine a compass course,
but using modern technology. This technology lesson will help you achieve just
that.

Topic

Calculating the distance between two coordinates
and angle to the azimuth

Subjects

Technology, Computing, Mathematics, Geography

Level
Aims

programming with App Inventor
 learning to create an application using App

Skills

Inventor
 applying mathematical skills to understand the
app
 data collection from the internet
 applying coordinates

Duration
Resources

150 minutes of classroom work


Android phone



the app

“ Mit AI2 Companion” (can be found

on the play store)


Wifi



Gmail account



a computer with internet connection
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INTRODUCTION
What is MIT App Inventor?
MIT App Inventor is an innovative beginner's introduction to programming and app creation that
transforms the complex language of text-based coding into visual, drag-and-drop building blocks.
The simple graphical interface grants even an inexperienced novice the ability to create a basic,
fully functional app within an hour or less.

History
Google's Mark Friedman and MIT Professor Hal Abelson co-led the development of App Inventor
while Hal was on sabbatical at Google in 2009. Other early Google engineer contributors were
Sharon Perl, Liz Looney, and Ellen Spertus. App Inventor runs as a web service administered by
staff at MIT’s Center for Mobile Learning - a collaboration of MIT’s Computer Science and Artificial
Intelligence Laboratory (CSAIL) and the MIT Media Lab.

Setting Up App Inventor
In order to get access to ai2.appinventor.mit.edu you will need a Gmail account!!!!
You can set up App Inventor and start building apps in minutes. Internet Explorer is not supported.
Use Chrome or Firefox. The Designer and Blocks Editor run completely in the browser. To see
your app on a device while you build it (also called "Live Testing"), you'll need to follow the steps
below.
You have three options for setting up live testing while you build apps.
 If you are using an Android device and you have a wireless internet connection, you
can start building apps without downloading any software to your computer. You will need
to install the App Inventor Companion App (download MIT AI2 Companion from the play
store) on your device.
 If you are using an Android device and you do not have a wireless internet
connection, you'll need to install software on your computer so that you can connect to
your Android device over USB.
 If you do not have an Android device, you'll need to install software on your computer so
that you can use the on-screen Android emulator.
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Activity 1
Setting up the app
Visit the page: ai2.appinventor.mit.edu
Login with your Gmail account
From the menu Projects select Start new project

Give a name to your project (Permitted characters: English alphabet and underscore, without
spaces) For this project give the name Distance_Calculator

If you have followed the instructions, you will see the following screen.
Palette: Find your
components and
drag them to the
Viewer to add them
to your app.

Viewer: Drag
components from
the Palette to see
what your app will
look like.

Components: All the
components you have
dragged from the
Palette to the Viewer
will appear.
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Properties: Select a
component in the
component list to
change its
properties (size,
colour, ..).

Activity 2
Setting up the User’s interface
In order to create an app that calculates the distance in kilometres between two coordinates and
shows you the angle to the azimuth, you have to follow the following steps. The final layout of your
screen will be:

1.Horizontalarrangement

Label

2.Horizontalarrangement
1.Button

3.Horizontalarrangement

Label

4.Horizontalarrangement
TextBox

2.Button
5.Horizontalarrangement
Label

6.Horizontalarrangement

7.Horizontalarrangement

Button

Picture 1

Setting up the component screen
Be sure that you have clicked on the Designer button.
Download a picture of a location pin from the internet and save it to your computer.
For the Screen1 component insert the following properties:
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AppName
BackgroundColor
Icon
Title

Location
LightGray
Upload the picture you have
downloaded
Distance Calculator

On the Viewer drag 6 HorizontalArrangements, 2 Buttons and a LocationSensor ( as seen in Picture1).
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To rename a component click on the button Rename and insert a new name.
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Insert the following properties for each component:
1. HorizontalArrangement
Palette
Layout

Component
HorizontalArrangement

Name
lat1Arrangement

Properties
BackgroundColor:
none
Height: Automatic
Width: Fill parent

Drag in the Lat1Arrangement
UserInterface label

latitude

UserInterface

lat

FontSize:20
Height: Automatic
Width: 140
Text: Latitude:
FontSize:20
Height: Automatic
Width: 140
BackgroundColor:
white

label

2.HorizontalArrangement
Palette
Layout

Component
HorizontalArrangement

Name
longArrangement

Properties
BackgroundColor:
none
Height: Automatic
Width: Fill parent

Drag in the longArrangement
UserInterface label

longitude

UserInterface

lon

FontSize:20
Height: Automatic
Width: 140
Text: Longitude:
FontSize:20
Height: Automatic
Width: 140
BackgroundColor:
white

label

Selection Height / Width: "Automatic" means that the size of the label is adapted to the
content, and Height / Width: "Fill parent" means that it occupies all the available space.
Rename the Button1 to getlocation.
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Insert the following Properties for the 1st Button.
Palette
UserInterface

Component
Button

Name
getlocation

Properties
BackgroundColor:
Gray
Text: Get location
Height: Automatic
Width: Fill parent
FontSize:20

Name
lat2Arrangement

Properties
BackgroundColor:
none
Height: Automatic
Width: Fill parent

Inside the Lat2Arrangement drag
UserInterface label

latitude2

UserInterface

lat2TextBox

FontSize:20
Height: Automatic
Width: 140
Text: Latitude2:
default

3.HorizontalArrangement
Palette
Layout

Component
HorizontalArrangement

TextBox

4. HorizontalArrangement
Palette
Layout

Component
HorizontalArrangement

Name
Properties
long2Arrangement BackgroundColor:
none
Height: Automatic
Width: Fill parent

Inside the long2Arrangement drag
UserInterface label

longitude2

UserInterface

lon2TextBox

TextBox

FontSize:20
Height: Automatic
Width: 140
Text: Longitude2:
default

Labels are components used to show text. A label displays text which is specified by
the Text property. Other properties, all of which can be set in the Designer or Blocks
Editor, control the appearance and placement of the text.
Users enter text in a text box component. The initial or user-entered text value in a text
box component is in the Text property. If Text is blank, you can use the Hint property to
provide the user with a suggestion of what to type.
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Insert the following Properties for the 2nd Button.
Palette
UserInterface

Component
Button

Name
calculate

Properties
BackgroundColor:
Gray
Text: Calculate
distance
Height: Automatic
Width: Fill parent
FontSize:20

Name
kmArrangement

Properties
BackgroundColor:
none
Height: Automatic
Width: Fill parent

Inside the kmArrangement drag
UserInterface label

distance

UserInterface

km

FontSize:20
Height: Automatic
Width: Automatic
Text: 0
FontSize:20
Height: Automatic
Width: Automatic
Text: km

5. HorizontalArrangement
Palette
Layout

Component
HorizontalArrangement

label

6. HorizontalArrangement
Palette
Layout

Component
HorizontalArrangement

Inside the angleArrangement drag
UserInterface label

Name
Properties
angleArrangement BackgroundColor:
none
Height: Automatic
Width: Fill parent
angle

FontSize:20
Height: Automatic
Width: Automatic
Text: 0
UserInterface label
degrees
FontSize:20
Height: Automatic
Width: Automatic
Text: degrees
Add another HorizontalArrangement to put the image of a compass. Download an image of a
compass that contains degrees. Clicking on the image will open a second screen that has a
compass that rotates and indicates the North.
Compass functionality in phones and tablets is enabled by a sensor called a
magnetometer, which is used to measure the strength and direction of magnetic
fields. By analyzing Earth's magnetic field, the sensor allows a phone to determine its
orientation . Most Android devices/phones have a magnetometer.
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7. HorizontalArrangement
Palette
Layout

Component
HorizontalArrangement

Name
compassArrangement

Properties
Height: Automatic
Width: Fill parent

Inside the compassArrangement drag
UserInterface label

click

UserInterface

compass

FontSize:14
Height: Fill parent
Width: 120
Text: Click on the
icon to see the
compass.
Height: 80
Width: 80
Image: name of
downloaded picture

Button

The last component to be added is a LocationSensor.
Palette
Sensors

Component
LocationSensors

Name
Locationsensor1

Properties
default

The location sensor object is used to communicate with the global positioning satellite
receiver (GPS) in your phone/tablet. When the LocationSensor communicates with the
built-in GPS receiver, the GPS can determine the location of your device. The sensor
can also work with network/wifi location services. Finding a location using the network
uses very different techniques to determine a location. Location means, the device's present
latitude and longitude or it can mean your street address.
After all these steps the final version of the Viewer for Screen1 is the following.

19

Add a new Screen.

Insert the following Components.
Palette
Drawing and
Animation

Component
Canvas

Name
Canvas1

UserInterface

Button

backButton

In the Canvas drag an imagesprite
Drawing and
ImageSprite
Animation

Sensors

compass

Properties
BackgroundColor: White
Height: Fill parent
Width: Fill parent
BackgroundColor: Gray
Text: back
Height: Automatic
Width: Automatic
Picture: Upload the
picture of a compass
Height: 300
Width: 300

OrientationSensor OrientationSensor1 Enabled
A 'sprite' can be placed on a Canvas, where it can react to touches and drags. It can
also interact with other sprites and the edge of the Canvas, and move according to its
property values. Its appearance is that of the image specified in its Picture property.
An image component displays an image. You can specify the picture to display and
other aspects of the image's appearance in the Designer or in the Blocks Editor.

This will be the layout for the second Screen.
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Activity 3
Programming the App
Go to screen 1. Go to Menu Blocks.

Click on the LocationSensor1 in the Block segment and drag the block on the Viewer.

Define where it will receive the coordinates from.
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Do the same for component lon. Put the blocks into the control block.

Click on

in order to open the menu and choose the block "get latitude".

The result is

To program the "get location" button click on the component getlocation and drag the block into
Viewer
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Select component LocationSensor1 and drag the block into the Viewer.

From the built-in Blocks Logic select the block "true".

The result is

You will now have to set variables to calculate the distance.
A global variable is a variable that can be accessed in multiple scopes. This means
that wherever you are in the program you can use that variable; get its current value or
set its value to something else. Global variables are created using the “initialize global
name to” block found in the Variables drawer.
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Give names as shown above.

Click and insert the name.
You have to create two procedures, one for calculating the distance and one for the heading.
A procedure is a sequence of blocks or code that is stored under a name, the name of
your procedure block. Instead of having to keep putting together the same long
sequence of blocks, you can create a procedure and just call the procedure block
whenever you want your sequence of blocks to run. In computer science, a procedure
also might be called a function or a method.
When you create a new procedure block, App Inventor chooses a unique name
automatically. You can click on the name and type to change it. Procedure
names in an app must be unique. App Inventor will not let you define two
procedures in the same app with the same name. You can rename a procedure at any time while
you are building the app, by changing the label in the block. App Inventor will automatically rename
the associated call blocks to match.
When you create a procedure, App Inventor automatically generates a
call block and places it in the My Definitions drawer. You use the call
block to invoke the procedure.

You have to define a procedure named "distance". Select from the built-in Blocks the Procedures
and drag the second block to the Viewer
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When you create a procedure, you can use
the
mutator button to add arguments.
An argument is an input to our procedure.

Click on the mutator. Drag and drop 4 arguments (inputs). Give the names lat1, long1, lat2 and
long2 for each argument.

Add the block as seen above.

By hovering your mouse over an
argument, you will see a get and set
block appear. Drag these blocks
onto your screen to use them.
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Create a new procedure “angle” the same way you created the procedure “distance”.
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Put the necessary blocks together to create the following result.

Connect the blocks as seen above in order to program the "calculate" button.
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If you want to check if every formula is correct, go to http://www.movabletype.co.uk/scripts/latlong.html
Clicking on the image of the compass will open a second screen, showing the picture of the
compass we had downloaded. Put the blocks together as seen above.

Go to the second screen to add the blocks.

Using the knowlegde from the previous activities, put the blocks together.

To return to the first screen click the button "Back".
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Activity 4
Click on the menu Connect and select AI Companion.

On your Screen you will see the picture above.

Go to the app MIT AI2 companion that you have downloaded on your mobile phone, open it and
click Scan QR code.
If you followed the steps, you will see the app on the screen of your phone.
If you want to install the app on your phone go to Menu Build and select the first option

Have fun!!!!!!
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PART 3
In this engineering part we will design and construct measuring devices for measuring
angles. Sailors in Mercator’s days used similar devices to determine their position.
In case you want to elaborate on this subject you will find more content in “STEAM 1
engineering English version”.

Topic
Subjects
Level

Design and construction of angle measuring tools
Engineering, Mathematics, Technology, ICT

Activity 1-2 :
Activity 3-4-5

Aims

Students get acquainted with former angle and
distance measuring methods.
Students improve an old measuring instrument with
present day technology.
Students learn to use the instrument to measure the
height of an object.

Skills

Activity 1-2 : mathematical skills - IT
Activity 3-4-5 : designing measuring instruments
(technology and engineering).

Duration

Activity 1-2 : 50 minutes
Activity 3-4-5 : 2 to 6 x 50 minutes, depending on
preparation of classroom material by the teacher or
the students

Resources

Activity 1-2 : calculator, computer with internet
connection
Activity 3-4-5 : calculator, designing software,
printer, paper, material for construction (depends on
your own ideas), …
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INTRODUCTION
From all the angles in three-dimensional space we measure horizontal angles.(angle brackets lie in
a horizontal plane) and vertical angles (angle brackets lie in a vertical plane).
In the vertical angles one bracket of an angle may be in the horizontal plane, that is the vertical or
elevation angle or one bracket of an angle may be in the vertical direction, this is the zenithal angle
or zenith distance

α - the vertical angle, ZA - zenith angle, θ - horizontal angle
Figure 13: The angles in three-dimensional space

The horizontal angles have values ranging from 0° to 360° and increase clockwise.
The vertical or elevation angle can have values from 0° to 90° - in this case they are called
elevation angles – or from 0° to -90° then they are called depression angles. These always have a
negative value.
Zenithal angles or zenith distances have values ranging from 0° to 180 °. Zenithal and vertical
angles for the same direction are always complementary, and their sum equals 90° (Fig 14)

Figure 14 : Vertical and zenithal angles
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MEASURING THE ANGLES
Theodolites
The angles are measured by theodolites. The theodolite is the basic, most important surveying instrument
It is used to measure the horizontal and vertical angles and also the distance
(in combination with an electronic distance metre). (Figure 15).
Depending on the accuracy of angle measurement we know:
- the exact or so-called one-second theodolites ( precision of 2 '', 1 '' or less)
- ordinary theodolites ( accuracy is 0.1 minutes or more.
The accuracy of the measurement depends on the magnification and clarity of the telescope,
on the sensitivity and the vials of the components, which read the smallest part of the angle sectors.
Another differentiation of theodolites is based on their angular graduations and devices for reading
the values of an angle. In this way, theodolites are divided into:
- optical or analogue (the angle sectors are read with a microscope),
- electronic or digital (angular graduations enable electronic reading of angle values).
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Before the invention of theodolites angles were measured using the simplest device which were
not able to reach an accuracy of a few minutes or seconds, but at most of degrees. These devices
were the Jacob’s staff and the quadrant

Jacob’s staff
In the early 14th century the Frenchman Lewi Ben Garson assembled a new measurement
instrument named the cross-staff or the Jacob’s staff. It consisted of long laths divided into sections
with a shorter orthogonally attached measuring slider. When measuring with it, it was necessary to
regulate the cross so that the horizon was visible through the bottom end and the observed
celestial body over the upper end of the cross. The Jacob's staff was used in field measurements,
long into the 17th century, particularly where newly invented measuring instruments were not
accepted.

Quadrant
The Quadrant is the quarter segment of the circular astrolabe. It was first used to measure the
angular distance of two celestial bodies or two Earth points. Therefore, its use has gradually shifted
from the astronomical area to land surveying. The circular part with movable sight laths enabled
measuring vertical and horizontal angles. It was used even in the 18th century. The Quadrant had
to be calibrated in a stable position so that its plumb bob was straight down.
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ENGINEERING IN MERCATOR’S DAYS

The assignment
Make your own measuring instruments in order to determine
the height of a point at your school.

Suppose you live in Mercator’s days.
* Design a mechanical measuring instrument
in order to measure the vertical angle.
* Use a piece of rope to measure the horizontal
distance.

Activity 1: Designing a device to measure an angle
For students a theodolite is too difficult to construct.
A decent alternative is a quadrant, a device that was used in Mercator’s days or a Jacob’s staff..
Use graphic design software to design the quadrant/the Jacob’s staff. Don’t forget to take into
account that:* You can only use material that was available in Mercator’s days: wood, rope,
nails,…..
* The device must be mobile (portable), therefore not too large and heavy.
* The device must show the number of degrees.
* The device must show you an accurate reading of the angle under all
you are on a slope.

conditions. Even when

* You need to consider the “production capacity” of your school. Don’t design something that can’t
be built at your school.
Write a manual describing the assembly of the device.
Print the design of the device and its parts, preferably in 2D and 3D.
Assemble your device.
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Activity 2 - Designing a distance meter
For students an odometer would take too long to construct.
And don’t forget : you are supposed to live in Mercator’s days.
Describe how you will measure the horizontal distance.

Activity 3 - Measuring with your design

- In the field, mark your position-S and by using a manufactured device for measuring angles,
measure vertical angle α towards the top of the object - point T (building, tree).
-With your distance meter (or footsteps) measure the distance from point S to the object T'.
- Calculate the height of the object.
- Determine an extra point A and with the surveyor's tape measure the distance d1 from S to A.
- With the angle measuring device measure the horizontal angle α1 and α2 at points S and A
in the triangle SAT.
- Calculate the length d between points S and T' using the sine law.
- Calculate the height of the object.
- Evaluate the accuracy of the result obtained.
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PART 4
In this lesson we use sun and time in order to calculate our own position, in other words our
latitude and longitude.

Topic

Calculating the latitude and the longitude of your
position

Subjects

Mathematics, Geography, ICT

Level
Aims

Students learn to calculate the latitude and the
longitude of their position, based on measurements
and observation of the sun and its shadow.

Skills

observation of a natural phenomenon
applying mathematical skills to understand it
data collection from the internet
applying geographical terminology

Duration

100 minutes of classroom work

Resources

1m stick
3m thread
large nail
a metre
a calculator
a computer with internet connection
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DETERMINING YOUR POSITION ON EARTH
Parallels (circles of latitude) and meridians (lines of longitude)
The globe is subdivided in a number of parallel circles, parallel to the Equator and therefore called
the parallels. The Equator itself is positioned on 0° north or south. Starting from the Equator and
in the direction of the poles there are parallel circles to the North 90° N and to the South 90° S
There is a second subdivision in circles, all of them going through the North and South Pole: the
meridians. The Prime Meridian (0°) runs through the English village of Greenwich. Starting here
they run 180 degrees east (E) and west (W).

Seen from a mathematical point of view this means that our position on our planet is represented
by two angles: an angle of latitude and an angle of longitude. For position P, α is the angle of
longitude and β is the angle of latitude. Angle α tells you how many degrees to turn to the east,
angle β tells you how many degrees to move north in order to move from point Q (point of
intersection of Equator and Prime Meridian) to point P.
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Activity 1
Go to https://www.google.be/maps and determine the longitude and latitude of your school.
Type the address of the school. Right click on the position and read the coordinates.
Address of school :
Latitude:
Longitude:

LATITUDE AND A BIT OF HISTORY
As long as you stayed on shore, it was relatively simple to find your way around. When you went
out to sea, things became more difficult. That’s why till the 13th century sailors stayed close to the
coast.
In the 14th century they invented the Jacob’s staff or cross-staff. They used this device to
determine the angle between the position of the sun and the horizon.
This device was not only difficult to operate and interpret, also many sailors became blind on one
eye by looking straight into the sun.

You use the cross-staff to measure the angle at the time when the sun reaches its highest position.
You slide along the vertical cross-beam till you see the horizon in the bottom hole and the middle
of the sun in the top hole.
This allows you to determine angle θ between the sun and the horizon.
𝜃
𝑏
= tan
2
𝑙
Consequently you can determine your approximate latitude on 21 September and 21 March.
Latitude = 90° - θ
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Generally these measurements were conducted from the crow’s nest and this height needed to be
taken into account in order to correct the final result. Moreover, due to the refraction of the light the
sun’s light also seemed to come from higher up than was the case in reality. This needed to be
corrected as well.
For us the most important correction though is the angle of declination.
The Earth’s rotational axis is askew with the movement of the Earth around the sun (23.45°).
Therefore we need to correct the measured angle with the declination angle. In the northern
hemisphere we need to add the declination angle to the measured angle.
Around 21 March and 21 September this value is 0°. For these days the formula mentioned above
is valid. However, when measuring around 21 December the declination angle is -23.45° and when
measuring around 21 June it is +23.43°. If you don’t take this into account you end up with a
gigantic error.
On the internet you can find a multitude of formulas to calculate this declination angle. We use the
values we find on http://www.esrl.noaa.gov/gmd/grad/solcalc/
It allows you to accurately determine your latitude in the northern hemisphere on any which date
and at the moment when the sun reaches her highest point.
Latitude = 90° - θ+ 𝛿
Near the end of the 16th century the cross-staff was replaced by the quadrant. The English
captain John Davis even invented an improved quadrant which no longer required the observer to
look straight into the sun but allowed him to use the shadow the sun cast on the device.

The larger the quadrant, the more accurate the measurement.

It took until the end of the 18 century before the sextant was introduced. It allowed to measure
larger angles. This device uses mirrors and an eyepiece.

As a consequence observations of moon, planets and stars became more popular.
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CALCULATING YOUR LATITUDE BASED ON THE SUN

Activity 2
On a sunny day you plant a stick into the ground under a right angle. You make sure the stick is
perfectly perpendicular and measures 100 cm above ground. If possible keep a compass at
hand.
From about 11 am till 3 pm you measure the shadow every 15 minutes. Note down time and
length of the shadow in the table underneath.

You will notice that the length varies. The sun doesn’t always rise exactly in the east. This only
happens on 21 March and 21 September. But the sun always reaches its highest point in the
exact south. And that’s also when you get the shortest shadow.
If you are unlucky and the weather is bad, you can always use information from the site
http://planetcalc.com/1875/

Date :
Geographic coordinates :
Length of stick :
Declination 𝛿:
http://www.esrl.noaa.gov/gmd/grad/solcalc/
Which time zone?
Greenwich Mean Time (GMT) – Central European Time/winter time (GMT + 1) – summer time
(GMT + 2) – GMT + …
https://greenwichmeantime.com/time-gadgets/time-zone-converter/
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Time
11:00

Length of shadow in cm

Time
12:30

11:15

12:45

11:30

13:00

11:45

13:15

12:00

13:30

12:15

13:45

Which time zone?
GMT - GMT + 1 – GMT + …

Length of shadow in cm

Local time when sun in the
exact south

Length of shadow in cm

Draw a graph. The vertical axis shows the length of the shadow, the horizontal axis shows the
time. Determine the minimal length of shadow from the graph.
Length of shadow(cm)

11:00 11:15 11:30 11:45 12:00 12:15 12:30 12:45 13:00 13:15 13:30 13:45 14:00 14:15 14:30 14:45 15:00

Local time
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Calculate the angle
tan 𝜃 =

length of stick
length of shadow

𝜃=

Calculate your latitude : latitude = 90° - θ+ 𝛿 =

Does the result please you?
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CALCULATING YOUR LONGITUDE

Activity 3
The Earth makes one revolution in easterly direction every 24 hours.
How many degrees does the Earth revolve in 1 hour?

How long does it take the Earth to spin 1°?

Your school is located at
How much sooner/later than in Greenwich will the sun reach its highest point at your school?

A partner school Jämtlands Gymnasium Wargentin in Sweden is located at 63.178649 N and
14.641960 E. How much sooner/later than at your school will the sun reach its highest point
here?

And what about the other schools?
latitude

VTI Veurne in Belgium
Jämtlands Gymnasium
Wargentin in Sweden
Conservatorio de musica
do Porto in Portugal
Istituto Superiore statale
del Tigullio Deabrosis
Natta in Italy
Srednja gradbena,
geodetska in
okoljevarstvena šola
Ljubljana in Slovenia
1st High School of
Alexandroupolis in Greece

longitude

51.063491 N
63.178649 N

2.666616 E
14.641960 E

41.155383 N

-8.623508 W

44.270784 N

9.400515 E

46.073182 N

14.513430 E

40.852364 N

25.871708 E
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time
compared
to your
school

time
compared to
Greenwich

The Earth’s speed around the Sun is not constant, though. And this also determines time.
Therefore we determine a Solar Mean Time. This is the time when considering the speed of the
Earth around the Sun to be constant. The difference between the apparent solar time and the
Solar Mean Time is called the equation of time.
The equation of time is represented by the line on the graph underneath. This varies from - 14
minutes around 11 February to +16 minutes around 3 November.

A positive equation of time is the number of minutes that the apparent solar time runs ahead of the
Mean Solar Time. A negative equation of time means the apparent solar time runs behind.
It is not very practical when every place has its own time. That’s why, near the end of the 19th
century, they subdivided the Earth in 24 time zones, each covering 15°. The Greenwich meridian
was decided to be the 0 meridian. The area where the time is considered to be equal to the
Greenwich time runs from about 7.5° W to 7.5° E.

The Mean Solar Time at Greenwich is used as the base for global time calculation and is called
Greenwich Mean Time (GMT or UTC).
Apart from that we also have Central European Time, which is GMT+1.
In summer some countries turn back their clocks an extra hour, which is the Central European
Summer Time (GMT+2).
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Activity 4
What is today’s date?
Go to http://www.esrl.noaa.gov/gmd/grad/solcalc/ and look up when the sun is at its highest in
Greenwich.
At the same day, when does the sun reach its highest point at your school ?

And at the schools of the project? ( local time – local time Greenwich)
local time

Which local
time?
+0/+1/+…

GMT

VTI Veurne, Belgium
Jämtlands Gymnasium Wargentin in
Sweden
Conservatorio de musica do Porto,
Portugal
Istituto Superiore statale del Tigullio
Deabrosis Natta, Italy
Srednja Gradbena, geodetska in
okoljevarstvena šola, Slovenia
1st High School of Alexandroupolis,
Greece
Our measurements:
local time
+0/+1/+…

local time when the sun is at
its highest / precisely south

length of shadow in cm

Calculate your longitude:
GMT of the moment the sun reaches its highest point at your location:

GMT of the moment the sun reaches its highest point in Greenwich:

Longitude =

𝑡𝑖𝑚𝑒 𝑑𝑖𝑓𝑓𝑒𝑟𝑒𝑛𝑐𝑒(min)
60

𝑥 15°
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PART 5
Topic

Creating a virtual tour on Google Earth

Subjects

Art, ICT, Geography, Technology, Mathematics

Level
Aims

Skills

Duration
Resources

Increasing digital skills.
Getting better knowledge of your region, its art and
culture.
Using the self-developed measuring instruments.
Calculating the height of a building or work of art.
Taking pictures and a 360° surround picture.
Developing social skills during group work.
Presenting results in front of an audience.
collaboration
organization
selection of information
peer-to-peer presentation
ICT skills
20 minutes introduction + 90 minutes outdoor + 60
minutes ICT work
computer
digital photo camera
Google Earth
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INTRODUCTION

Google Earth is a computer program developed by the Google company. Google’s main objective
is to present a three-dimensional model of the terrestrial globe. This image was composed from
satellite images and aerial photography. This program can be used to present two-dimensional
maps and satellite images and as a simulator of several landscapes of Planet Earth. With this
feature we can identify places, buildings, cities, landscapes ...
In a first phase it was known as Earth Viewer and developed by Keyhole, Inc. that was acquired by
Google in 2004. It was renamed Google Earth in 2005. It is available for use on personal
computers with various configurations of Microsoft Windows, Mac OS X 10.3.9 or higher, Linux and
FreeBSD.
This activity intends to use Google Earth to create digital and virtual study visits.

Activity 1

We subdivide the class in groups of 4 students. One student will be the photographer, one will be
the guide, another one is the reporter and the last one is the technician.
From the maths lesson we already know our position. The guide notes down the coordinates of
our starting point on a sheet of paper. Using the app we made in the technology class the guide
will lead the way towards four places in the town that are determined by their longitude and
latitude.
At every spot the photographer will take five artistic pictures of the surroundings. At one location
the photographer will also take a 360° surround picture. See activity 3 now to learn more about this
before leaving for the walk.
The reporter will look for noteworthy information and tries to describe the location in about five
sentences. The technician is armed with the measuring equipment constructed during the
engineering lesson and chooses one of the locations to measure the height of a building or work of
art.

Activity 2
Back at school the students create a virtual tour on Google Earth. Finally, the teacher lets each
group present their answers and findings to the whole class. The teacher comments on the
reflections of the students.
Download Google Earth: https://www.google.com/earth/download/ge/agree.html
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Creating a virtual tour on Google Earth
1. Open Google Earth.

2. Right click on Temporary places, Add Folder.

3. On the Name tab choose the name you want for your tour.
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4. Create placemarks to be included in the tour. This can be done by searching the place and then
selecting the better view. You can even move the placemark around to choose the right spot.

5. Now you can select the yellow pin on the above bar and name the place marks under the name
tab.
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6. You can add pictures or text to the placemark. Right click on the placemark yellow pin selecting
Properties. This allows you to add a description to your placemark and a picture. To add a picture
from the internet first get the web address from your browser and copy it. Click “Add web image”
and paste in “Image Url”. To add pictures from your computer hard disk, click “Add local image”
and select from your computer.

7. After choosing all place mark properties, click Ok. The properties can be edited by right clicking
your placemarks on the map or in the list.
8. In the end the itinerary can be saved by choosing the option ‘Save place as’ under the ‘File tab’.
This will create a file with extension .kmz
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9. The time lapse between placemarks can be edited under Tools>Options>Touring

10. Now you can see your tour by left clicking the folder icon that is shown in the bottom corner of
the Places window.

Activity 3
In this activity we create a surround picture that we could add to our virtual tour on Google Earth.
On your tour you can choose a location where few people are around. Moving people will ruin the
result.
Use your mobile phone (and if possible a tripod) to take a set of pictures from the same location.
After each picture, rotate the camera horizontally for a certain number of degrees. Continue this
way till you have taken pictures of the entire surroundings. Make sure there is 20% to 30% overlap
between pictures so that the computer program can easily stitch the pictures.
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A tripod will help you to avoid the parallax problem. When the lens of your camera turns on its
own axis, objects will be equally aligned in adjacent pictures. When you hold the camera in front of
you in order to take pictures, the viewpoint of your lens changes with every rotation and picture you
take. And consequently the computer program will not be able to align and stitch adjacent images
properly.
Finally also take a picture of the sky above and one of the surface where you or your tripod are
standing. We will try to combine all these pictures into 1 surround picture.

Making a surround picture
1. Run the program PTGui Pro

2. In the first screen press the button “Load images…” and select all images

3. Press “Align images” and wait …
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4. Save Project (Ctrl+S) with name Demo
5. Press button “Create Panorama”
6. Change to “Width=5000” and press button “Create Panorama”

7. Go to Tools → Publish to Website

8. Press button “Add Files”

9. Select the file Demo.jpg and press convert
10. Run the created Demo.htm file
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Add logo to the picture
There is a problem at the bottom of the image: the tripod or your feet!

We remove this by replacing this spot by our logo.
1.
2.
3.
4.
5.
6.

Find the image (with tripod or feet) and open it with Photoshop.
Find “the steam.jpg” image or make your own logo and drag it into Photoshop.
Scale the image to overlap the tripod.
Save the new image with a name like for example “tripod.jpg”.
Go to PTGui in the “Source Images” tab.
Find the image with the tripod or your feet and select it.

7.
8.
9.
10.
11.
12.
13.
14.
15.

Press the button “Replace” and choose the image with the logo.
Go to the “Mask” tab.
Select the image with the logo.
Choose the green pen and paint the logo image.
Go to the tab “Create Panorama” and press the button “Create Panorama”.
Choose “Yes” to overwrite the panorama.
Repeat the step “Publish to Website”
Save the project.
Run the new Demo.htm.
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